PERFORMANCE AND DURABILITY COMPARISON:
DELL LATITUDE 14 5000 SERIES VS. LENOVO THINKPAD T440

Dell Latitude 14 5000 Series

Powered by Intel” Core™ i5-4200U processor

Better durabhility

on PT’s hands-on tests

Longer hattery life

on MobileMark® 2012

versus Lenovo® ThinkPad® T440

When you’re looking to purchase new business-class notebooks for a wide
range of employees, durability and superior performance should dictate your choice.
In the Principled Technologies labs, we put the performance and durability of
two systems to the test: the Dell Latitude 14 5000 Series (E5440) and Lenovo ThinkPad
T440. We purchased systems that were configured as similarly as possible, with the
exception of the drive type (the Dell system had a solid-state hybrid drive while the
Lenovo system used a traditional hard disk drive) and the battery. At Dell’s request, we
configured each notebook with the default battery. We found that:
e the systems performed comparably on the tests that we ran
e the Dell Latitude 14 5000 Series was better able to withstand being
dropped to the floor from a height of 29 inches, suffering no damage to
the hard drive after three drops
e the Lenovo ThinkPad T440 failed completely after only the second drop
e the Dell Latitude 14 5000 Series had longer battery life, outlasting the
ThinkPad T440 by just over two hours.
The solid performance of the Dell Latitude 14 5000 Series coupled with its
increased durability means that it can handle the tasks you need it to while also
standing up to potential damage.
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DURABILITY TESTING

When workers are on the go, accidents sometimes happen. Not all notebooks

do an equally good job of surviving a fall. To see how our two test systems compared,

we attempted to drop each system three times from a height of 29 inches (73.7 cm), or
about desk-high. After each drop, we used HD Tune Pro 5.00 and HDDScan 3.3, tests

that assess hard drive damage, to measure how well the system had protected its data.

Once a system failed to boot, we conducted no further testing on that system. See

Appendix A for detailed hardware information.

The Dell Latitude 14 5000 Series proved the more durable of the systems,

sustaining no damage to the hard drive after three drops. During the second drop, the

Dell Latitude 14 5000 Series suffered minor cosmetic damage, with the DVD drive

faceplate breaking on one side. The Lenovo ThinkPad T440 survived the first drop, but
failed after the second with 98.8 percent bad blocks. The ThinkPad T440 crashed during
the HDDScan and would not boot again, so we did not complete a third drop on the

system.

Figure 1 summarizes the results of our hard drive scans.

Drop testing — physical data protection

Dell Latitude 14 5000 Series |  Lenovo ThinkPad T440
Drop 1
HD Tune Pro 5.00 damaged blocks percentage 0.0% 0.0%
HDDScan 3.3 bad blocks 0 0
Drop 2
HD Tune Pro 5.00 damaged blocks percentage 0.0% 98.8%
HDDScan 3.3 bad blocks 0 N/A
Drop 3
HD Tune Pro 5.00 damaged blocks percentage 0.0% N/A
HDDScan 3.3 bad blocks 0 N/A

Figure 1: The results of our physical data protection drop test for the notebooks.
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BATTERY LIFE COMPARISON

No one likes to be tethered to an outlet to do his or her work, so a system with
lengthy battery life is always a plus. As Figure 2 shows, the Dell Latitude 14 5000 Series
had a significantly longer battery life than the Lenovo ThinkPad T440, outlasting it by
roughly two hours using the BAPCo® MobileMark® 2012 benchmark.
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Figure 2: The Dell Latitude 14
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single charge. S 200 |
100 -
0 -

Dell Latitude 14 5000 Series Lenovo ThinkPad T440

The Latitude also delivered a higher Performance Qualification score (see Figure
3).The Dell Latitude 14 5000 Series battery shipped with a single 65 WHr battery, while
the Lenovo ThinkPad T440 shipped with two 24 WHr batteries, which can account for
the difference in battery life.

BAPCo MobileMark 2012

Dell Latitude 14 5000 Series Lenovo ThinkPad T440
Performance Qualification score 123 119
MobileMark 2012 - Battery Life score (minutes) 533 412
MobileMark 2012 - Battery Life score (hours: minutes) 8:53 6:52

Figure 3: Median scores for the BAPCo MobileMark 2012 benchmark. Higher numbers are better.

PERFORMANCE TESTING

Because performance is so important to today’s worker, we used a number of
benchmarks to rate the performance of the notebooks, and found that the Dell Latitude
14 5000 Series was up to completing the tasks workers require. We ran each test three
times and report the median of the three runs.

Futuremark® 3DMark® Advanced rates a system’s graphics performance by
testing the video card. Both systems had integrated Intel HD Graphics 4400 graphics
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adapters. We found that two systems performed comparably in this test, with the

Lenovo ThinkPad T440 achieving a slightly higher score (see Figure 4).

3DMark Advanced
Dell Latitude 14 5000 Series Lenovo ThinkPad T440

3DMark Score - Median 3,955 4,011
Graphics Score 4,896 4,967
Physics Score 2,365 2,379
Graphics Test 1 21.00 21.31
Graphics Test 2 21.59 21.89
Physics Test 7.51 7.61

Figure 4: Median scores for the 3DMark Advanced benchmark. Higher numbers are better.
HDXPRT 2012 measures the performance of systems on common media usages.
Figure 5 shows the median results of our HDXPRT 2012 tests. The Dell Latitude 14 5000
Series had a 1.3 percent higher Create HD Score than the Lenovo ThinkPad T440.

HDXPRT 2012
Dell Latitude 14 5000 Series Lenovo ThinkPad T440

Create HD Score (higher is better) 154 152

Media Organizer - minutes (lower is better) 6.57 6.76

Media Creator - minutes (lower is better) 13.86 13.96

Photo Blogger - minutes (lower is better) 9.69 9.98

Video Producer - minutes (lower is better) 2.83 2.87

Music Maker - minutes (lower is better) 3.39 3.39

Figure 5: Median scores for the HDXPRT 2012 benchmark.

BAPCo SYSmark® 2012 measures system performance for a number of common
tasks including office productivity and media creation. Figure 6 shows the median
results of our SYSmark 2012 tests. The Dell Latitude 14 5000 Series achieved a 3.6
percent higher SYSmark 2012 Overall Performance Rating than the Lenovo ThinkPad

T440.
BAPCo SYSmark 2012
Dell Latitude 14 5000 Series Lenovo ThinkPad T440

SYSmark 2012 Overall Performance Rating 114 110
SYSmark 2012 - Office Productivity 116 110
SYSmark 2012 - Media Creation 104 103
SYSmark 2012 - Web Development 104 101
SYSmark 2012 - Data/Financial Analysis 127 121
SYSmark 2012 - 3D Modeling 111 110
SYSmark 2012 - System Management 124 117

Figure 6: Median scores for the BAPCo SYSmark 2012 benchmark. Higher numbers are better.
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WHAT WE TESTED

About BAPCo MobileMark 2012

BAPCo MobileMark 2012 is an industry-standard benchmark that provides a
battery life rating and a performance rating based on common office scenarios.
MobileMark 2012 uses applications and workloads specific to mobile systems. These
include office activities like file and document management, data processing, and rich
content creation. This module provides a score for battery life of the tested applications.

MobileMark 2012 measures system battery life in minutes. It records system
battery life at the start of the benchmark and repeats the workload until the system
battery life is depleted, or until the system powers down due to low battery life.

For more information on this benchmark, see

www.bapco.com/products/mobilemark2012/index.php.

About Futuremark 3DMark Advanced

About HDXPRT 2012

The Futuremark 3DMark Advanced benchmark suite tests system GPU DirectX®
11 performance and CPU workload processing performance, primarily to report a
system’s 3D gaming capability. Tests include HDR rendering, shadow mapping, and pixel
shading. For more information on this benchmark, see

www.futuremark.com/benchmarks/3dmark/all.

The High Definition eXperience & Performance Ratings Test (HDXPRT) 2012 is a
benchmark that evaluates the capabilities of PCs in consumer digital media uses,
including the following:

e Media Organizer
e Media Creator
e Photo Blogger
e Video Producer
e Music Maker
For more information on HDXPRT 2012, see www.hdxprt.com.

About BAPCo SYSmark 2012

BAPCo SYSmark 2012 is an application-based benchmark that tests performance
in the following office workload scenarios: office productivity, media creation, Web
development, data/financial analysis, 3D modeling, and system management. SYSmark
2012 records the time the system takes to complete each individual operation in each
scenario. For more information on this benchmark, see

www.bapco.com/products/sysmark-2012.
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IN CONCLUSION

Durability and performance are important when selecting a notebook for
employees in the workplace. The Dell Latitude 14 5000 Series performed comparably to
or better than a similarly configured competitor system while also withstanding three
drops without compromising physical data. The Lenovo ThinkPad T440 failed after two
drops. This means that the Dell Latitude 14 5000 Series should handle common tasks for
work and be durable enough for workers on the go.
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APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 7 provides detailed configuration information for the test systems.

System

Dell Latitude 14 5000 Series (E5440)

Lenovo ThinkPad T440

General

Number of processor packages

Number of cores per processor

Number of hardware threads per core

Total number of processor threads in
system

1
2
2
4

1
2
2
4

System power management policy

Dell

Energy Saver

Processor power-saving option

Enhanced Intel® SpeedStep®
Technology

Enhanced Intel SpeedStep
Technology

System dimensions (width x depth x
height)

13.3"x9.3"x1.1"

13.3" x9.15" x 0.8"

System weight 4.9 lbs. 3.9 lbs.

CPU

Vendor Intel Intel

Name Core™ i5 Core i5

Model number 4200U 4200U

Stepping Cco Co

Socket type Socket 1168 BGA Socket 1168 BGA
Core frequency (GHz) 1.60 1.60

System Bus Intel DMI 5 GT/s Intel DMI 5 GT/s
L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 256 KB (per core) 256 KB (per core)
L3 cache 3 MB 3 MB

Platform

Vendor Dell Lenovo
Motherboard model number ORT36Y 20B6CTOIWW

Motherboard chipset

Intel 8 series chipset

Intel 8 series chipset

BIOS name and version

Dell AO1 (09/18/2013)

Lenovo GIET64WW (2.14)
(11/12/2013)

Memory module(s)

Vendor and model number

Samsung® M471B5173BDO0-YKO

Samsung M471B5173QHO0-YKO

Type

PC3-12800

PC3-12800

Speed (MHz) 1,600 1,600
Speed running in the system (MHz) 1,600 1,600
Tlmlng/Latency (tCL-tRCD-tRP- 11-11-11-98 11-11-11-8
tRASmIn)

Size (MB) 4,096 4,096
Number of memory module(s) 1 1

Total amount of system RAM (GB) 4 4
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System Dell Latitude 14 5000 Series (E5440) Lenovo ThinkPad T440
Chip organization (single- . .
sided/double-sided) Double-sided Double-sided

Channel (single/dual) Single Single

Hard disk

Vendor and model number

Seagate® ST500LMO000-1EJ16

HGST Travelstar Z7K500

HTS725050A7E630
Number of disks in system 1 1
Size (GB) 500 500
Buffer size (MB) 64 32
RPM 5,400 7,200
Type SSHD SATA 6Gb/s SATA 6.0Gb/s
Controller Intel 8 series chipset Intel 8 series chipset
Driver Intel 12.6.2.1000 (05/20/2013) Intel 12.8.0.1016 (08/01/2013)
Operating system
Name Microsoft® Windows® 7 Professional Microsoft Windows 7 Professional
Build number 7601 7601
Service Pack 1 1
File system NTFS NTFS
Kernel ACPI x64-based PC ACPI x64-based PC
Language English English
Microsoft® DirectX version DirectX 11 DirectX 11
Graphics
Vendor and model number Intel HD Graphics 4400 Intel HD Graphics 4400
Type Integrated Integrated
Chipset Intel HD Graphics 4400 Intel HD Graphics 4400
BIOS version 2171.13 2175.0
Total available graphics memory (MB) | 1,696 1,696
Dedicated video memory (MB) 64 64
System video memory (MB) 0 0
Shared system memory (MB) 1,632 1,632
Resolution 1,366 x 768 1,366 x 768

Driver

Intel 9.18.10.3257 (07/29/2013)

Intel 9.18.10.3272 (08/08/2013)

Sound card/subsystem

Vendor and model number

Realtek High Definition Audio

Realtek High Definition Audio

Driver Realtek 6.0.1.5978 (08/01/2013) Realtek 6.0.1.7005 (07/31/2013)
Ethernet

Vendor and model number Intel Ethernet Connection 1218-LM Intel Ethernet Connection 1218-V
Driver Intel 12.6.51.9427 (07/09/2013) Intel 12.6.51.9427 (05/06/2013)

Wireless

Vendor and model number

Dell Wireless 1506

ThinkPad Wireless 2 x 2 BGN+BT 4.0
M.2 Adapter

Driver

Atheros 10.0.0.227 (02/19/2013)

Realtek 2010.6.807.2013
(08/07/2013)
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System

Dell Latitude 14 5000 Series (E5440)

Lenovo ThinkPad T440

Optical drive(s)

Vendor and model number HL-DT-ST GU9ON N/A

Type DVD+-RW N/A

Ports

uUsB 1xUSB2.0,2xUSB3.0 2xUSB 3.0

Other SD™ Media card reader, Mini DP, VGA, SD Media card reader, Mini DP, VGA
HDMI

Monitor

LCD type WLED-backlit HD TN LCD

Screen size 14.0" 14.0"

Refresh rate 60 60

Battery

Type Lithium-ion Lithium-ion

Size (length x width x height) 8.12" x 2.75" x 0.75" 8.12" x1.5" x 0.30"

Rated capacity 65 Wh 24 WHr internal, 24 WHr external

Weight 0.72 lbs. 0.33 lbs.

Figure 7: Configuration information for the test systems.
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APPENDIX B— HOW WE TESTED

Measuring digital media capabilities with HDXPRT 2012
Setting up the test

vk wN e

1.
2.
3.
4

5.
Measuring overall system performance with SYSmark 2012

Locate the optical drive or attach an external drive to the notebook.
Insert the HDXPRT DVD-ROM into the drive.

At the HDXPRT Install screen, click Install HDXPRT.

Accept the HDXPRT end user license agreement.

After the setup is complete, select Yes, | want to restart my computer now, and click Finish.
Running HDXPRT

Click the HDXPRT 2012 shortcut on the desktop.
Click Run HDXPRT.
Enter a test name, choose 4 iterations, and click Run.

The Results Screen automatically appears at the end of a successful run. The test results files are found in the

C:\ProgramFiles\HDXPRT\Reports\<TestName> directory.
Run the test one more time, and record the results.

Avoiding antivirus software conflicts

SYSmark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software that was

present on the notebook PCs before we installed the benchmark.
Avoiding pre-installed software conflicts

SYSmark 2012 installs the following applications, which its test scripts employ:

e ABBYY® FineReader Pro 10.0
e Adobe® Acrobat® Pro 9

e Adobe After Effects® CS5

e Adobe Dreamweaver® CS5

e Adobe Photoshop® CS5 Extended
e Adobe Premiere® Pro CS5

e Adobe Flash® Player 10.1

e Autodesk® 3DS Max® 2011
e Autodesk AutoCAD® 2011

e Google SketchUp® Pro 8

e Microsoft Internet Explorer®
e Microsoft Office 2010

o  Mozilla® Firefox® Installer

e Mouzilla Firefox 3.6.8

e  Winzip® Pro 14.5

If any of these applications are already on the system under test, they will cause problems with the benchmark

due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-

installed software applications, including different versions of any of the programs SYSmark 2012 uses.
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Setting up the test
Using the SYSmark built-in Configuration tool

This tool supports three levels of configuration:
1. Only makes changes that are REQUIRED in order for the benchmark to run.

2. Additionally, makes changes that are RECOMMENDED for repeatable results.

3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

e Disables User Account Control (UAC)

e Disables Windows Update

e Disables System Sleep and Hibernate

e Disables Low Battery Actions

e Disables Network Proxies

Level 2 - Recommended

e Creates BAPCo power scheme

e Sets Power Plan Type to High Performance
e Disables Windows Firewall

e Disables Windows Sidebar/Gadgets

e Disables Windows Pop-ups

e Disables Incoming Remote Desktop Connections
e Disables Windows Error Reporting

e Disables Screen Saver and Monitor Timeout
e Sets CPU Adaptive Mode

e Disables Desktop Slideshow

e Disables Disk Defrag

Level 3 - Optional

e Sets Hard Disk Timeout

e Disables Windows Defender

e Disables System Restore

e Ignores Laptop Lid Close

e Sets Maximum Display Brightness

e Disables Adaptive Brightness

Installing SYSmark 2012 and configuring the system for testing

Locate the optical drive or attach an external drive to the notebook.
Insert the SYSmark 2012 v1.5 Install DVD into the drive.

When the Autoplay menu appears, click Run SYSmark2012_setup.exe.
At the Welcome screen, click Next.

Enter the serial number, and click Next.

Accept the license agreement, and click Next.

Nouhswn e

At the Choose Components screen, select Full, and click Next.
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9.

10.
11.
12.

13.
14,
15.

At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\SYSmark2012,
and click Next.

At the Choose Start Menu Folder screen, click Install.

Insert Disc 2 when prompted.

At the InstallShield Wizard Complete screen, click Finish.

Download and install SYSmark 2012 v1.5 Patch 1 and v1.5.2 Patch 2 from
www.bapco.com/products/support/sysmark-2012.

Launch SYSmark 2012.

Click Configuration and choose all options.

Click Apply, and restart the computer when prompted.

Running the test

1.
2.
3.
4.

Launch SYSmark 2012 by double-clicking the desktop icon.

Enter a Project name and choose 3 iterations.

Click Run Benchmark.

Repeat steps 1 through 3 two more times, and record the last run.

Getting the SYSmark 2012 results

When SYSmark 2012 has completed, the Test Results Viewer appears. To submit these results to BAPCo, we

saved the test results by performing the following steps:

1.
2.
3.
4.

Click Save.

Enter a name, and select FDR to save the results as an FDR file.

Click Save again, and select PDF to save the results as a PDF file.

Browse to the Documents directory where the result FDR and PDF files were saved.

Measuring battery life with MobileMark 2012
Avoiding antivirus software conflicts

MobileMark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software

present on the notebook PCs before we installed the benchmark.

Avoiding pre-installed software conflicts

MobileMark 2012 installs the following applications, which its test scripts employ:
e ABBYY FineReader Pro 11

e Adobe Acrobat Pro X

e Adobe Flash Player 11

e Adobe Photoshop CS5 Extended 12.04
e Adobe Photoshop Elements 10

e Adobe Premiere Pro CS 5.5

e CyberLink PowerDVD Ultra 11

e Microsoft Excel 2010 SP1

e Microsoft Internet Explorer

e Microsoft Outlook 2010 SP1

e Microsoft PowerPoint 2010 SP1

e  Microsoft Windows Media Player
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e Microsoft Word 2010 SP1

e Mozilla Firefox 10.0.2

e WinZip Pro 16

If any of these applications are already on the system under test, they could cause problems with the
benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all
conflicting pre-installed software applications, including different versions of any of the programs MobileMark 2012
uses.

Adjusting display brightness and power settings

The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test
with MobileMark 2012, you do the following step: make sure the brightness of the notebook’s monitor is greater than or
equal to 150 nits on a completely white screen while the notebook is unplugged and running on battery power. The
measurement follows the standards from the Video Electronics Standards Association (www.vesa.org).

We complied with this standard for all the tests we ran by setting the notebook PC’s brightness as close to 150
nits as we could without going below that brightness level. We used the following procedure before we started each
test. Note: This procedure assumes we began with the notebook plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by clicking Start—>All Programs—>
Accessories—>Paint.

Press Ctrl+W to open the Resize and Skew dialog.

Under Horizontal and Vertical enter 200, and click OK.

Click the View tab.

Click Full screen to view a white screen.

Wait 45 minutes to allow the screen to warm.

NouvswnN

Unplug the notebook from the power supply, and measure the display’s brightness using a luminance meter in the

center of the screen. (We used the Gossen Mavolux5032C.)

8. If the reading is below or significantly greater than 150 nits, use the notebook’s keyboard screen-brightness-
adjustment keys to bring the display as close to 150 nits as possible, then retest.

9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or
down as necessary.

10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another
reading.

Note: If the notebook did not save the brightness setting, use its power management application(s) to set the
brightness appropriately, and save that setting. If saving the setting is ineffective, use the keyboard brightness setting
keys to adjust the screen to bring the display as close to 150 nits as possible. Next, note how many times you pressed
the button to achieve the desired brightness. After unplugging the system under test, use the keyboard to set the
desired brightness by pressing the brightness button as many times as you previously noted to return the screen to the
correct brightness level.

Using the MobileMark built-in Configuration tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED in order for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
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3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:
Level 1 - Required

Disables User Account Control (UAC)
Disables Windows Update

Disables System Sleep and Hibernate

Sets Screen Dimming Timeout (2 minutes)
Disables Low Battery Actions

Disables Network Proxies

Disables Autorun for Optical Drive

Level 2 - Recommended

Creates BAPCo power scheme

Sets Power Plan Type to balanced

Disables Windows Firewall

Disables Windows Sidebar/Gadgets
Disables Windows Pop-ups

Disables Incoming Remote Desktop Connections
Disables Windows Error Reporting

Disables Screen Saver and Monitor Timeout
Sets CPU Adaptive Mode

Disables Desktop Slideshow

Disables Disk Defrag

Level 3 - Optional

Sets Hard Disk Timeout

Disables Windows Defender
Disables System Restore

Ignores Laptop Lid Close

Sets Maximum Display Brightness
Disables Adaptive Brightness

Because we are testing how well each system does out-of-box, we chose only the Required options in the

Configuration tool.

Installing MobileMark 2012 and configuring the system for testing

NV A WDNPR

Verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the Internet.

Locate the optical drive or attach an external drive to the notebook.

Insert the MobileMark 2012 Install DVD into the drive.

When the Autoplay menu appears, click Run MobileMark2012_Setup.exe.

At the Welcome screen, click Next.

Enter the serial number, and click Next.

Accept the license agreement, and click Next.

At the Choose Components screen, select Full, and click Next.
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10.
11.
12.
13.
14.
15.
16.

At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\MobileMark2012,

and click Next.

At the Choose Start Menu Folder screen, click Install.

Insert Disc 2 when prompted.

At the InstallShield Wizard Complete screen, click Finish.

Launch MobileMark 2012.

Click Configuration and choose only the Required options.

Click Apply, and restart the computer when prompted.

Adjust the screen brightness to no less than 150 nits:

a. Click the Windows Start button, and type power options inthe Windows Start Search box.

b. Click Change plan settings.

c. Click Change advanced power settings.

d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct
percentage that produces no less than 150 nits.
Note: If you are unable to save these settings, please see the Displaying Brightness section above.

Conditioning the battery

1.

kW

9.

Plug the AC power adapter into the notebook PC, and completely charge the battery.

Install MobileMark 2012, following the steps we outlined in the Installing MobileMark 2012 section.

Double-click the MobileMark 2012 icon on the desktop.

Click the Office Productivity icon.

Type System Conditioning asthe name for this test in the Project Name, check the box next to conditioning,
and click Continue.

If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.

When prompted, unplug the AC power adapter. The Office Productivity test begins immediately.

The test is complete when the notebook PC has fully depleted its battery and is no longer operational when running
on battery power.

Plug the AC power adapter into the notebook PC, and completely charge the battery.

Measuring battery life with MobileMark 2012

el

g

We performed the following steps to run the MobileMark 2012 Office Productivity benchmark:
Double-click the MobileMark 2012 icon on the desktop.
Select the Office Productivity test by clicking the Office Productivity icon.
Enter a name for this test in the Project Name field, and click Continue.
If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.
When prompted, unplug the AC power adapter. The test begins immediately.
The Office Productivity test is complete when the notebook PC has fully depleted its battery and is no longer
operational when running on battery power.

We executed the MobileMark 2012 Office Productivity test three times on the system and took the median

battery life run as the representative score for that test.
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Getting the MobileMark 2012 results

After each MobileMark 2012 Office Productivity test completed, we plugged the AC power adapter into the

notebook PC and turned on the system. MobileMark 2012 started automatically after the system booted, then analyzed

the test scores and opened the Test Results Viewer with the results from the last test.

PwnN e

To submit these results to BAPCo, we saved the test results by performing the following steps:
Click Save.
Enter a name and select FDR to save the results as an FDR file.
Click Save again, and select PDF to save the results as a PDF file.
Browse to the Documents directory where the result FDR and PDF files were saved.

Measuring graphics performance with 3DMark Advanced
Installing 3DMark

1.

O NV A WD

9.
10.
11.

12.

Purchase 3DMark Advanced Edition from www.futuremark.com/store, and download the 3DMark-
_v110_installer.exe Windows package.

Install 3DMark by double-clicking the 3DMark_v110_installer.exe file; leave the default options set.
At the Choose Setup Language screen, choose English, and click Next.

At the Welcome screen, click Next.

At the License Agreement screen, click | accept the terms of the license agreement, and click Next.

At the Setup Type screen, click Complete, and click Next.

At the Ready to Install the Program screen, click Install.

When the 3DMark Read Me page appears in your Web browser, review the document, and click Close when you are
finished.

At the Setup Complete screen, click Finish to restart the computer.

Download and install the 3DMark patch 3DMark-v1-2-250.

Launch 3DMark Advanced by double-clicking on the 3DMark desktop icon. Enter the registration code, and click
Register.

Exit 3DMark Advanced.

Running 3DMark Advanced

1.
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Boot the system and open an administrative command prompt:
a. Click the Windows Start button.
b. Type cmd and right-click cmd.exe.
c. Select Run as administrator.
Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Double-click the 3DMark desktop icon to launch the benchmark.
In the 3DMark Main section, click the Performance option under Preset, and select Benchmark tests only.
Click Run 3DMark.
When the benchmark run completes, take a screenshot of the results, and record them as follows:
e 3DMark Score
e Graphics Score
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e  Physics Score
e  Graphics Test 1
e Graphics Test 2
e  Physics Test
9. Shut down the system.
10. Repeat steps 1 through 9 four more times, and report the median of the last three runs.

Measuring durability
This test measures the damage that the impact from a drop of 29 inches inflicts upon an open notebook running

PassMark® Burnin Test v7.1 Professional.
Setting up PassMark Burnln Test v7.1 Professional

1. Download PassMark Burnin Test v7.1 Pro from www.passmark.com/download/bit download.htm.

2. Install Burnln Test:

Double-click the Burnln Test bitpro_x64.exe file.

In the Setup — Burnln Test window, click Next.

Accept the agreement, and click Next.

Leave the default destination location, and click Next.

Leave the default folder name, and click Next.

Click Install.

At the Completing the Burnln Test Setup Wizard screen, click Finish.

When the Burnin Test by PassMark Software screen opens, enter the username and key, and click Continue.

S@m 0 a0 T o

3. Configure Burnln Test:

Click Configuration, and select Test Selection and Duty Cycles.

In the Test selection and duty cycles screen, set the CPU, 2D Graphics, 3D Graphics and Disk(s) fields to 25%.
Deselect all other tests that may be selected by default.

Click OK.

Click Configuration, and select Test Preferences.

Click the Disk tab, and check the Automatically select all hard drives at the start of testing box.

Click the Pre-Test tab, and select the None (start immediately) radio button.

h. Click OK.

Running PassMark Burnin Test v7.1 Professional
1. Launch PassMark Burnln Test v7.1 Pro by double-clicking the Burnin Test icon on the Desktop.
2. Start the test by clicking the green triangle.

Conducting the drop test

We used a Lansmont PDT56ED Precision Drop Tester, with a landing area covered by commercial carpet. We
opened the notebook so that the screen and keyboard formed a 120-degree angle, and then placed the notebook flat on
the platen. Orienting the notebook in this way resulted in a flat drop. (Figure 8 shows our test setup.)

To allow us to scan the notebooks identically, we booted to a Hiren’s BootCD and installed the hard disk
scanning software to the Microsoft Windows 7 virtual machine’s RAM disk. Running the scanning software from RAM,
we scanned the hard disk with HD Tune Pro 5.00 and HDDScan for Windows 3.3, and recorded the number of bad
sectors and blocks before and after the drop test. We also recorded any other physical defects, such as cracks or breaks
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in the display, as well as separated hinges or displaced Lansmont PDT56ED Precision Drop Tester
screws, which the impact of the drop caused. We took

still photographs of the notebooks before and after «—— Guide rail
each drop. We dropped each notebook once, using this
process: o
1. Install PassMark Burnin Test v7.1 Pro onto the test Peumatic cylinder
notebook, as outlined above. o
«———  Unit raised and
2. Run HD Tune Pro 5.00 and HDDScan 3.3 to get ’ lowered by electric

chain hoist
baseline data on the state of the hard disk. Boot the

system using a Hiren’s BootCD.
a. Install HD Tune Pro 5.00:

i Insert a USB flash drive containing the HD
Tune Pro installation executable, and click
once on My Computer.

ii. Navigate to the USB drive, and double-click
the hdtunepro_500 _trial.exe installation

file to install the application. e
iii. At the welcome screen, click Next.

iv.  Click the I accept the agreement radio Commercial-grade

. carpeting
button, and click Next.

V. In the Select Destination Location window, ‘ l

click Browse. Figure 8: Our physical durability test setup.
vi. Click the RAMDisk drive once to select it,
and click OK.
vii.  Click Next in the next two windows.
viii. Leave check box empty for Create a desktop icon, and click Next.

ix.  Click Install.
X. Leave the check box checked for Launch HD Tune Pro, and click Finish.
b. Run the HD Tune Pro 5.00 Error Scan:
i.  Select the Error Scan tab.
ii.  Click Start in the right hand pane.

Note: The Error Scan is complete when the Start button changes from grey to black.
c. Save the Error Scan Results.

d. Click the Copy information to clipboard button on the upper right hand menu bar (it is the first button on the left):
i.  Open a new text file by clicking Start->Run, typing notepad, and clicking OK.
ii. In the Notepad window, click Edit=>Paste.
iii.  Click File=>Save As, enter an appropriate filename using a . txt extension, and choose the location to save
the file (we saved ours to a USB flash drive). Click Save.
e. Close the HD Tune Pro 5.00 Hard Disk Utility.
f. Scan the notebook’s hard drive with HDDScan for Windows version 3.3:
i.  Open the HDDScan folder, and double-click the HDDScan.exe executable file to run the application.
ii. Click Tasks=>Surface Tests to open the Test Selection window.
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10.
11.
12.

iii. Select Verify from the list of tests, and click Add Test.
iv. At the conclusion of the run, double-click the VR-Verify test id in the Test Manager window to open up the
results.
V. Select the Report tab, and copy and paste the test results into Notepad.
vi.  Save the results as a text file.
Set the height of the platen on the Lansmont Precision Drop Tester to 29 inches above the surface of the 28-ounce
commercial carpeting.
Place the fully-charged notebook onto the platen of the drop tester, with the notebook’s base flat on the platen and
the screen facing forward, open at a 120-degree angle.
Launch PassMark Burnin Test.
Unplug the notebook, and drop the notebook onto the commercial carpeting.
Wait until the notebook is completely still.
If the battery or any other components come off the system, inspect them for damage, and reinstall them if
possible.
Take digital pictures of the notebook from all angles after completing the checklist.
Stop PassMark Burnin Test.
Reconnect the notebook’s AC adapter.
Run HD Tune Pro 5.00 and HDD Scan 3.3 using the process in Step 2, and record the results as the notebook’s post-
test disk status.

Performance and durability comparison: A Principled Technologies test report 19
Dell Latitude 14 5000 Series vs. Lenovo ThinkPad T440



ABOUT PRINCIPLED TECHNOLOGIES

» We provide industry-leading technology assessment and fact-based
Principled marketing services. We bring to every assighnment extensive experience
‘ ITechnoIogies® with and expertise in all aspects of technology testing and analysis, from
researching new technologies, to developing new methodologies, to

. . testing with existing and new tools.
Principled Technologies, Inc.

1007 Slater Road, Suite 300
Durham, NC, 27703 When the assessment is complete, we know how to present the results to

www.principlectechnologies.com a broad range of target audiences. We provide our clients with the
materials they need, from market-focused data to use in their own
collateral to custom sales aids, such as test reports, performance
assessments, and white papers. Every document reflects the results of
our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software, Web
sites, or services, we offer the experience, expertise, and tools to help our
clients assess how it will fare against its competition, its performance, its
market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked
together in technology assessment for over 20 years. As journalists, they
published over a thousand articles on a wide array of technology subjects.
They created and led the Ziff-Davis Benchmark Operation, which
developed such industry-standard benchmarks as Ziff Davis Media’s
Winstone and WebBench. They founded and led eTesting Labs, and after
the acquisition of that company by Lionbridge Technologies were the
head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.
ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED
TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR
DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S
TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.
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